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Export Compliance Notification 
INEXA™ Control is a commercial software applications identified under Export Control Classification Number (ECCN) EAR99.  No 
Export License is required for the export/re-export of these applications to non-US persons other than those from or in US 
Government imposed embargoed / sanctioned countries identified in the Supplement 1 to Part 740 (Country Group E) of the Export 
Administration Regulations (EAR). However, an export license is required for export/re-export to non-US persons from or in those 
embargoed / sanctioned countries. It is the responsibility of the individual in control of this related technical material to abide by the 
U.S. export laws.  

You acknowledge that the technical material is subject to U.S. export jurisdiction and that the technical material may only be 
exported from the United States in accordance with United States export laws. You also acknowledge that any diversion contrary to 
United States law is prohibited, and also agree to comply with all applicable non-U.S. export/import control laws that apply to the 
technical material. This includes end-user, end-use, and destination restrictions issued by the U.S. Government and other 
governments.  

You also agree not to export, re-export, import, transfer, or release the technical material to embargoed or sanctioned countries, in 
whole or in part to include: 

(a)  Into (or to a national resident of) any country to which the U.S. maintains embargoes or other restrictions,  

(b)  To any person on the US Treasury Department's list of Specially Designated nationals or, 

(c)  To any person or entity on the US Commerce Department's Denied Persons List, Entity List or Unverified List or, Table of Deny 

Orders or, 

(d)  To any person or entity subject to a General Order 3 to Part 736 of the U.S. Commerce Department’s Export Administration 

Regulations or, 

(e)  The U.S. Department of State’s Parties Subject to Nonproliferation Sanctions List or, 

(f) To any person or entity or into any country where such export, re-export, or import violates any US, local, or other applicable 

import/export control laws or regulations. 

Version Notification 
A newer version of this document may be available on the Insitu product application site. You should always use the most current 

version of this document. 
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INEXA Control System Requirements 

Minimum Requirements 
 Windows 7 Professional or Ultimate (64-bit), Service Pack 1 

 Processor: Quad Core, 2.2 GHz, 6MB Cache 

 Memory: 4 GB DDR3 1600 MHz 

 Storage: 64 GB Solid State Drive 

 Graphics Card: 1 GB GDDR5 Dedicated Memory, DirectX 11.0, Shader 5.0 Gaming Card 

 Display Resolution: 1280 x 1024 at 96 DPI 

Recommended Configuration 
 Windows 7 Professional or Ultimate (64-bit), Service Pack 1 

 Processor: Quad Core, 2.5 GHz, 8MB Cache 

 Memory: 6 GB DDR3 1600 MHz 

 Storage: 256 GB Solid State Drive 

 Graphics Card: 2 GB GDDR5 Dedicated Memory, DirectX 11.0, Shader 5.0 Gaming Card. 

Note:  NVIDIA Quadro M2000 has been thoroughly tested. 

 Display Resolution: 1920 x 1080 at 96 DPI 
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INEXA Control Installation 
INEXA Control can be installed by launching the Setup.exefile contained on the installation media that you received. 

Only one instance of each version of INEXA Control can be installed at a time. 

1. Close all other running applications to ensure INEXA Control will be installed fully and correctly. 

2. Right-click the Setup.exefile on your provided installation medium and select ‘Run as Administrator’ 

 
3. Input the appropriate username and permissions or clicking 'Yes' on the User Account Control prompts that may appear. 

 

4. Read the End-User License Agreement, clicking the "I Agree" button when finished. 
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5. Accept the default install directory or choose a custom install directory, then click the “Next” button. 

 
 



© 2017 Insitu Inc., All Rights Reserved Page 5 Insitu Proprietary 
 

6. Accept the default mission data directory or choose a custom mission data directory. 

 

Note: The “Mission Data” directory is where routes, annotations, and other mission data are stored. Mission data can be copied 

from one INEXA Control station to another by copying and pasting the Mission Data folder from one station into another 

station. Mission data is located in the C:\ProgramData\Insitu\Inexa Control 2.1\MissionData folder. 

7. If a software dependency pre-requisite is not met, a few additional prompts may be presented. 

a. If prompted, click ‘Next’ to begin the installation of Microsoft .Net Framework 4.5 

 
b. Unpacking the .Net Framework 4.5 installer 
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c. Accept Microsoft .Net Framework 4.5 license terms and click ‘Install’ to begin 

 
d.  If prompted, click ‘Next’ to begin the Xbox 360 controller driver installation process 
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e. Accept Microsoft Xbox 360 Accessory license agreement and click ‘Next’ to being the install 

 
f. Click ‘Finish’ to move on with installing INEXA Control 

 
8. When ready to proceed, click "Install" to begin the installation process. 

9. Wait for INEXA Control to fully install and click “Finish” when complete. 
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10. Click on the “Windows” icon in the lower left-hand corner of the PC, and then select “All Programs”, “Insitu”, and “INEXA 

Control 2.1”. In the INEXA Control program folder, click on the “INEXA Control 2.1.2 Simulation” to start the application and 

complete the installation process. 

 

Note: For quick future access, click on “INEXA Control Simulation” and drag it to the Windows toolbar. 

11. When running the INEXA Control application for the first time, the application will prompt you to enter a license key.  
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12. An “ICOMC2.lic” file will be sent to you via email when you purchase the software. To activate the INEXA Control software, 

complete the following license registration process: 

a. Locate the “ICOMC2.lic” file, right-click on the icon, and select the “Open With…” option. In the Windows dialog box, 

select the “Select a program from a list of installed programs” and click on the “OK” button. 
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9b. In the “Open with” dialog box, select the “Notepad” option, then click on the “OK” button. 

 

9c. In the “Notepad” application, select and copy the license key text, paste the text into the “INEXA Control License Key Entry” 

field indicated below, and click on the “Launch ICOMC2” button. 

Copy and Paste Key Commands 

 To select all license key text within Notepad, press the “Ctrl+A” keys simultaneously. 

 To copy the license key text, press the “Ctrl+C” keys simultaneously. 

 To past the license key text into the “INEXA Control License Key Entry” field, mouse-click the license key input field then 

press the “Ctrl+V” keys simultaneously. 
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Note: After pasting the license key text into the license key input field, the application will verify the license key. If the license 

key “verifies”, the word “Verified” with a green checkmark will appear in the lower left-hand corner of the input box. 

13. A User Account Control prompt may appear for ICOMC2RegisterControls.exe. At the prompt click ‘es’ or input a user account 

and password that has permissions to allow this program to register some additional libraries before first application startup. 

 
14. A Windows Firewall window or other third-party firewall application may prompt for the creation of a firewall rule/exception to 

enable INEXA Control to use network resources. Please allow access on the desired networks that INEXA Control is expected to 

operate.  
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15. Once the license key is verified, the INEXA Control installation is complete and the application will launch. If an active 

connection to the internet is available the online maps should automatically load by default.

 
Note: Close the INEXA Control application prior to installing INEXA Control plugin software.  
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Application Overview 

Note: When INEXA Control is first installed, the primary map display is provided by the Esri ArcGIS™ Online 

map service. This map service is provided for basic mission planning only and is not recommended for 

flight or product demonstration purposes. The ArcGIS Online map service requires Internet connectivity. 

INEXA Control allows for offline map packs to be created through the Online Map Creation Wizard or 

through using 3rd party GIS software. Please see “Map Panel – Map Management Controls” section 

located in this document, then return to this section. 

INEXA Control Overview 
The following are the INEXA Control main menu and primary control options. 

 

Home Menu – System hardware configuration and workspace management options 

Application Menus – Application functionality segmented by functionality type 

Map Panel – The main operations panel used for flight and mission planning 

Tracker Panel – The main sensor control panel used for video or still picture capture 

Video Panel – The video display panel similar to the Tracker Panel without payload control functionality 

Flight Control Panel – The primary flight control and status messaging panel 
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Home Menu 
The Home Menu provides access to system hardware configuration and workspace management options. 

 

Network Explorer – Display and update components on the UAS network 

Normal Procedures – Display normal operational procedures (requires that “Normal Procedures” be installed) 

Emergency Procedures – Display emergency procedures (requires that “Emergency Procedures” be installed) 

Manage Procedures – Utility for installing normal or emergency procedures 

Quick Grid – Arrange primary displays in a grid pattern 

Toggle Full Screen – Toggle in and out of full screen mode (F11) 

Add Display – Add additional Tracker, Video, or Custom screens 

User Feedback – Provide user product input or bug notification back to Insitu (requires Internet connectivity) 

Reset Workspace – Reset the INEXA Control workspace back to the default configuration 
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Application Menus 
The INEXA Control application utilizes a ribbon style menu to help users quickly find the commands to complete a task. Commands 

are organized into logical groups, which are collected together under tabs. Each tab relates to a type of activity, such as managing 

map imagery. To reduce clutter, some tabs are shown only when needed. For example, the Tracker Tools tab is shown only when 

the Tracker Panel is selected. 

Note: Not all INEXA Control menu functionality will be available for all unmanned vehicle operations. 

Mission Planning 
The mission planning menu provides access to functionality required for planning future missions. 

 

Points of Interest – Create and manage points of interest 

Route Editor – Create and manage routes and waypoints 

Mission Limits – View and set mission limits 

Mission Execution
The mission execution menu provides access to aircraft systems and mission information and tools. 

 

Launch and Recover – Controls required to launch and recover a vehicle 

Flight Control – Functions required to manage aircraft controls 

Aircraft Systems – Controls for managing features that may be on aircraft 

Mission – Controls for viewing and configuring mission and security metadata for imagery and managing chat with other INEXA 

Control stations 

Tools – Display vehicle location, metadata encoded in video streams, and system message history 
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Training 
The training menu provides access to controls and configuration options for simulated aircraft operations. 

 

Simulation Controls – Aircraft simulation controls for starting and stopping simulations 

Simulation Panels – Manage the simulation location, quick launch, and basic aircraft information 

Scene Designer – Add dynamic objects to the video stream (e.g. trucks, helicopters, etc.) 

Settings 
The settings menu provides access to application and network settings. It also displays available plugin applications that an operator 

can enable or disable. 

 

Application Settings – User definable application configuration settings 

Network Settings – Add and configure network addresses and ports, and specify settings for publishing vehicle or sensor point of 

interest information 

Plug-ins – Manage plugin applications for use in INEXA Control 

Map Tools 
The map tools menu provides access to application tools required for map and map overlay management. 

Note: To access the Map Tools menu, click on the Map Panel. 

 

Files – Install, remove, and manage map files 

Routes – Create routes and view the aircraft altitude profile relative to the immediate terrain 

Pan & Zoom – Controls to pan and zoom in/out on map imagery 

Overlays – Add or remove pertinent system information, imagery, or annotations over the map 

Settings – Miscellaneous settings to auto-position map imagery based on aircraft location, dim the map display, or configure map 

settings

 Note: Notice in this menu group that the Auto Follow option is highlighted, indicating that it is active. Auto Follow causes 

the map to reposition anytime the active vehicle is not visible on the map. To toggle this feature on and off, simply click on 

the Auto Follow icon. 
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Tracker Tools 
The tracker tools menu provides access to application tools required for sensor or payload management. 

Note: To access the Tracker Tools menu, click on the Tracker Panel. 

 

Payload Station – Select available payload stations for control within the Tracker Panel 

Control – Take or release control of payload station(s) 

Camera Settings – Activate or stow payloads and adjust available camera settings 

Lasers – Arm/Disarm lasers (range finding) 

Display Scale – Camera zoom, scale in and out 

Capture – Add tags and annotations to objects identified in the video steam and take a snapshot of a single frame from the 

streaming video imagery 

Reticle – Display and adjust reticle overlay settings 

Settings – Configure overlay and snapshot settings. Also, manage annotations and other images that overlay video imagery 

Joystick – Select and manage available payload joystick controls 

Video Tools 
The video tools menu provides access to application tools available to users who don’t need sensor payload control functionality, 

but do need access to video sensor or payload management controls. 

Note: To access the Video Tools menu, click on the Video Panel. 

 

Video Source – Select available payload stations or other available video sources 

Display Scale – Scale in or out on video imagery 

Capture – Add tags and annotations to objects identified in the video steam and take a snapshot of a single frame from the 

streaming video imagery 

Reticle – Display and adjust reticle overlay settings 

Settings – Configure overlay and snapshot settings. Also, manage annotations and other images that overlay video imagery 

Joystick – Select and manage available joystick controls 
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Tracker Panel - Camera Activation 
To activate the camera payload and manage basic payload control, perform the following steps: 

1. Select the Tracker Panel. 

2. From the Payload Station menu group, select <Select a Station> and then select from the available camera option(s). 

3. From the Control menu group, select Take to take control of the payload. 

4. From the Camera Settings menu group, select Operating Mode, and then select the Activate option. 

Note: The camera should activate at this point. 

5. On the Tracker Panel on the far right side is the camera pan up/down slider control; click on the Slider Arrow and drag it down 

to between 45 and 90 degrees. 
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Tracker Panel – Video Management Controls 
INEXA Control provides video management control functionality for systems equipped with a radio and camera required for live 

video management. The following functions may be available for use within the Tracker Panel and your aircraft: 

Adjusting the Sensor Point of Interest 
INEXA Control provides functionality to reposition the Sensor Point of Interest (SPOI) without the need to reposition the aircraft. To 

adjust the SPOI location, perform the following steps: 

1. To pan the camera left or right, adjust the slider control located at the top of the Tracker Panel. 

2. To pan the camera up or down, adjust the slider control located on the right-side of the Tracker Panel. 

3. To direct the camera focus to a specific location on the video, mouse-click at that point on the Tracker Panel video display. 

7 
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Adjust Camera Focus 
INEXA Control provides functionality to adjust the camera focus. To adjust camera focus, perform the following steps: 

1. Select the Scale In button to zoom in the camera focus. 

2. Select the Scale Out button to zoom out the camera focus. 
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Creating Points of Interest 
INEXA Control provides functionality to identify specific points of interest viewable from the Tracker Panel video display. To identify 

points of interest from the Tracker Panel video display, perform the following steps: 

1. Select the Mark Single button to identify a point of interest on the video display. 

Note: This also creates a pin-drop on the Map Panel. 

 

Creating Points of Interest with Snapshots 
INEXA Control provides functionality of taking snapshots of the Tracker Panel video display when creating points of interests using 

the Mark Single button. To add snapshots when using the Mark Single button, perform the following steps: 

1. From the Tracker Panel, select the Snapshot button, then 

2. Select the Snapshot on Mark Single box (one time task). 

3. Select the Mark Single button to identify a point of interest on the video display. 
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3 
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Take a Snapshot
INEXA Control provides functionality to take a snapshot of the current video image and store it in a file on the PC. Snapshots and any 

associated metadata are stored in the:   C:\Program Files (x86)\Insitu\Inexa Control 2.1\ICOMC2\MissionData\ICOMC2 Imagery 

folder. To take and view snapshots, perform the following steps: 

1. From the Tracker Panel, select the Snapshot button, then 

2. Select the File type to select the image save type (one time task). 

3. Select the Take Snapshot button to take a snapshot of the current video image. 

 
4. Open Windows Explorer and navigate to: 

 C:\Program Files(x86)\Insitu\Inexa Control 2.1\ICOMC2\MissionData\ICOMC2 Imagery 

 
Note: To include an image with overlays, and any corresponding metadata, make sure the Include Overlays checkbox is 

checked in Step 2 above. 

3 
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Add and Adjust Reticle Settings 
INEXA Control provides functionality to add a reticle overlay over the top of a video image. This feature is beneficial for determining 

the relative direction and size of an object. To add and adjust a reticle image overlay, perform the following steps: 

1. From the Tracker Panel, select the Reticle button. 

2. Select the Left, Right, Minus (-), and Plus (+) buttons to adjust the reticle orientation and the distance between reticle tick 

marks. 

3. Select the Reticle Fixed Distance button and enter a specific value to set the reticle tick marks to specific distances. 

Note: The reticle tick distance measurement can be found at the bottom of the reticle. 
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Effects – Video Overlays 
INEXA Control utilizes Insitu’s patented Augmented Video Overlay System (AVOS) to overlay important mission information over the 

top of or around video imagery. Some overlays, like the terrain warning overlay, activate when needed. Others can be turned on and 

off when needed by the operator. To manage overlays, perform the following steps: 

1. Within the Tracker Panel, select the Effects button and note the available options. 

 Off – Turn off Effects overlays 

 Map – Display data overlaid on 3D terrain 

 Detectability – Display vehicle detectability overlaid on 3D terrain 

 Unsafe Elevation – Display unsafe elevation overlaid on 3D terrain 

 Wireframe – Display a 3D terrain wireframe 

 Shaded – Display flat shaded 3D terrain 

EffectsOverlay–MapOverlaySample

2. Select the Scale Out button three-times. 

3. Select Effects then, 

4. Select the Map option. 

Note: INEXA Control wraps the video image with map imagery. This allows the operator to focus closely on a specific point of 

interest while maintaining situational awareness. 
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Overlays 
INEXA Control provides functionality that overlays video imagery with important mission information. To manage important 

information overlays, perform the following steps: 

1. Within the Tracker Panel, select the Overlays button. 

2. Modify the Overlay Settings options as desired. 

3. Click on the Cycle Color button to select a text color option that displays best against the video background. 

4. Select the check boxes to enable or disable desired Enabled Overlays options. 

5. Select a previously identified Point of Interest in the Distance Measurement section. 

6. Select a second previously identified Point of Interest in the Distance Measurement section. 

7. Select the Plus (+) option button to measure the distance between the two Points of Interest. 

Note: Adding multiple Points of interest within the Distance Measurement section will create measurements between each set of 

Points of Interest. The measurement located in the middle of the measurement line identifies the distance between the two Points 

of Interest. The measurement located near each Point of Interest is the distance from the Point of Interest to the vehicle. 
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Overlay Visibility 
INEXA Control provides additional overlay management functionality that allows operators to specify specific point of interest, 

annotation, and shapefile overlays that should or should not be visible. To specify which specific overlays should or should not be 

visible, perform the following steps: 

1. After selecting the Overlays button, select the Visibility tab. 

2. Check or un-check the point of interest, annotation, and or shapefile overlays that should or should not be visible. 

Note: Checked items are visible on the Tracker Panel; unchecked items will not be visible in the Tracker Panel. 
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Joystick Camera Control 
INEXA Control provides joystick video camera control functionality that provides payload camera control using a compatible joystick. 

To enable joystick video camera control functionality, perform the following steps: 

1. After plugging in a compatible joystick, select the Tracker Panel Joystick button. 

2. Select a compatible joystick option. 

3. Select the Manual button located at the bottom of the Tracker Panel. 

4. Manually steer the camera payload using the joystick controller. 

Note: INEXA Control will display a white dot “Lead Indicator” on the Tracker Panel video screen when steering a gimbaled camera 

payload using a joystick controller. The white dot is an indicator of where the camera will be looking in 300 milliseconds and helps 

reduce the operator induced oscillation that occurs when operators “over-drive” the camera in response to radio communication 

delays between the computer and the vehicle. If a “white dot” does not appear when steering the camera, select Overlays in the 

Settings section on the Tracker Panel and check the Joystick Lead Indicator option. 

Note: Joystick video camera control functionality is only available in the Tracker Panel and is not available in the Video Panel. The 

Video Panel is available for persons who need access to basic video controls, but who are not responsible for payload management. 
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Video Panel – Video Source Selection 
To select an active camera payload and manage basic payload functionality, perform the following steps: 

1. Select the Video Panel. 

2. From the Payload Station menu group, select <Select a Station> and then, 

3. Select from the available camera option(s). 

Note: Only active camera(s) or other video sources will be available for selection. Cameras can only be activated from the Tracker 

Panel. 

 

Note: Valid video sources may include vehicle payloads as well as video sources from Network, File, Capture Card, and RTSP 

sources. See the Application Settings – Video Sources section for instructions for linking to these sources. Once a video source link is 

established, the video source will be available for selection in Step 3 listed above. 
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Video Panel – Video Management Controls 
INEXA Control provides video management control functionality for systems equipped with a radio and camera required for live 

video management. The following functions may be available for use within the Video Panel and your aircraft: 

Adjust Camera Focus 
INEXA Control provides functionality to adjust the camera focus. To adjust camera focus, perform the following steps: 

1. Select the Scale In button to zoom in the camera focus. 

2. Select the Scale Out button to zoom out the camera focus. 
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Creating Points of Interest 
INEXA Control provides functionality to identify specific points of interest viewable from the Video Panel display. To identify points 

of interest from the Video Panel display, perform the following steps: 

1. Select the Mark Single button to identify a point of interest on the video display. 

Note: This action also creates a pin-drop on the Map Panel. The point of interest name and other related information can be 

managed from the Mission Planning, Points of Interest management control. 
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Take a Snapshot
INEXA Control provides functionality to take a snapshot of the current video image and store it in a file on the PC. Snapshots and any 

associated metadata are stored in the:   C:\Program Files (x86)\Insitu\Inexa Control 2.1\ICOMC2\MissionData\ICOMC2 Imagery 

folder. To take and view snapshots, perform the following steps: 

1. From the Video Panel, select the Snapshot button, then 

2. Select the File type to select the image save type (one time task). 

3. Select the Take Snapshot button to take a snapshot of the current video image. 

 
4. Open Windows Explorer and navigate to: 

 C:\Program Files(x86)\Insitu\Inexa Control 2.1\ICOMC2\MissionData\ICOMC2 Imagery 

 
Note: To include an image with overlays, and any corresponding metadata, make sure the Include Overlays checkbox is 

checked in Step 2 above. 

2 
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Add and Adjust Reticle Settings 
INEXA Control provides functionality to add a reticle overlay over the top of a video image. This feature is beneficial for determining 

the relative direction and size of an object. To add and adjust a reticle image overlay, perform the following steps: 

1. From the Video Panel, select the Reticle button. 

2. Select the Left, Right, Minus (-), and Plus (+) buttons to adjust the reticle orientation and the distance between reticle tick 

marks. 

3. Select the Reticle Fixed Distance button and enter a specific value to set the reticle tick marks to specific distances. 

Note: The reticle tick distance measurement can be found at the bottom of the reticle. 
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Effects – Video Overlays 
INEXA Control utilizes Insitu’s patented Augmented Video Overlay System (AVOS) to overlay important mission information over the 

top of or around video imagery. Some overlays, like the terrain warning overlay, activate when needed. Others can be turned on and 

off when needed by the operator. To manage overlays, perform the following steps: 

1. Within the Video Panel, select the Effects button and note the available options. 

 Off – Turn off Effects overlays 

 Map – Display data overlaid on 3D terrain 

 Detectability – Display vehicle detectability overlaid on 3D terrain 

 Unsafe Elevation – Display unsafe elevation overlaid on 3D terrain 

 Wireframe – Display a 3D terrain wireframe 

 Shaded – Display flat shaded 3D terrain 

EffectsOverlay–MapOverlaySample

2. Select the Scale Out button three-times. 

3. Select Effects then, 

4. Select the Map option. 

Note: INEXA Control wraps the video image with map imagery. This allows the operator to focus closely on a specific point of 

interest while maintaining situational awareness. 
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Overlays 
INEXA Control provides functionality that overlays video imagery with important mission information.  To manage important 

information overlays, perform the following steps: 

1. Within the Video Panel, select the Overlays button. 

2. Modify the Overlay Settings options as desired. 

3. Click on the Cycle Color button to select a text color option that displays best against the video background. 

4. Select the check boxes to enable or disable desired Enabled Overlays options. 

5. Select a previously identified Point of Interest in the Distance Measurement section. 

6. Select a second previously identified Point of Interest in the Distance Measurement section. 

7. Select the Plus (+) option button to measure the distance between the two Points of Interest. 

Note: Adding multiple Points of Interest within the Distance Measurement section will create measurements between each set of 

Points of Interest.  The measurement located in the middle of the measurement line identifies the distance between the two Points 

of Interest.  The measurement located near each Point of Interest is the distance from the Point of Interest to the vehicle. 
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Compatible Joysticks 
INEXA Control provides joystick access within the Video Panel. Although payload management functionality (e.g. steering the 

camera) is not available in the Video Panel other functionality may be accessible through joystick key bindings (e.g. Mark Target, 

Take Snapshot, Laser Range, Laser Marking, etc.). To select a joystick for use in the Video Panel, perform the following steps: 

1. Within the Video Panel, Joystick menu group, select the <select> option. 
2. Within the Compatible Joystick selection box, select an available joystick. 

 

 



© 2017 Insitu Inc., All Rights Reserved Page 37 Insitu Proprietary 
 

Map Panel – Map Management Controls 
INEXA Control provides map management functionality that assists operators with managing flight and mission operations. The 

following may be available for use within the Map Panel and your aircraft. 

Map Management 
By default, INEXA Control is installed with access to a global online map service provided that Internet connectivity is available to the 

computer. For instances when reliable Internet connectivity is not available, or when better resolution map imagery is required to 

complete mission operations, INEXA Control also provides the ability to create offline maps from online sources as well as load and 

use previously generated map images from ESRI ArcGIS for desktop.  

Loading Online Maps 
1. Select the Map Panel. 

2. From the Map Tools menu, select the Map Management option from the Files menu group  

3. In the Map Management panel, select Online map then click Activate  

4. Use the drop-down menu beside URL to select the desired map view such as “Open Street Map” 

 

3 
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Creating Offline Maps through Create Map Pack Wizard 
INEXA Control allows users to create offline maps from online map sources (often referred to as “Map Packs”) that support the 

Export Tiles functionality through the Create Map Pack wizard. Internet connectivity is required for this wizard. After the completion 

of each step of the wizard a green check box will appear next to each completed step. To use the wizard, perform the following 

steps: 

1. Select the Map Panel. 

2. From the Map Tools menu, select the Map Management option from the Files menu group.

3. In the Map Management panel, select Online map then click Activate. 

4. In the Map Management panel, select the Create Map Pack button to start the wizard. 
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5. Use the drop-down arrow  to the left of Step 2 – Name and Source to open the dialog for Step 2. 

6. Enter the name for the offline map to be created in the Name field and press Enter. 

7. Use the drop-down menu beside Online Source: and select the desired online map source; wait for map tiles to load on the 

Map Panel. 

8. Use the drop-down arrow  to the left of Step 3 – Region of Interest to open the dialog for Step 3. 

9. Specify the desired region of interest by either: 

a. Adjust the zoom in the Map Panel.  Push Capture Map Extents button to capture the extents of the map’s current 

view. 

b. Input the top left and bottom right coordinates of the desired rectangle by selecting the Type field beside the Top 

Left and Bot Right then enter the coordinates and press Enter for each Type field. 

10. Use the drop-down arrow  to the left of Step 4 – Elevation Source to open the dialog for Step 4. 

11. Select the Digital Terrain Elevation Data Source by either: 

a. Select Global DTED (Low Resolution) or 

b. Select User Defined DTED. Select an available .flt Map Packs (to create see Appendix A: Offline Map Creation then 

select Open. 

12. Use the drop-down arrow  to the left of Step 5 – Download to open the dialog for Step 5. 

13. Select Download button to download map pack. The download size will vary but will not exceed 300 megabytes. 

14. A visual alert will appear at the bottom right when completed. The downloaded map pack with the name entered in step 6 

will appear in the Map Management panel. Follow the Loading Offline Maps instructions for loading map. 

4 

3 
2 

3 
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Creating Offline Maps From 3rd Party Sources 
INEXA Control can use Offline Map Packs created through ESRI’s ArcGIS for desktop.  Please refer to Appendix A: Offline Map 

Creation. 

Loading Offline Maps 
To load map files, perform the following steps: 

1. Select the Map Panel. 

2. From the Map Tools menu, select the Map Management option from the Files menu group.

3. In the Map Management panel, select the Add button to add a map pack. 

 

Note: The default location where map packs should be saved is: 

 C:\Program Files (x86)\Insitu\Inexa Control 2.1\ICOMC2\DataFiles\maps 
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4. Select an available Map Pack option then, 

5. Select Open. 

 

6. In the Map Management panel, select the newly loaded map pack then, 

7. Select the Activate button. 

 

Note: Map packs typically cover small areas and can be difficult to locate when the map pack is activated.  If this occurs, select the 

Zoom All option from the Pan & Zoom menu group to reposition the map. 

Locating Map 
1. Select the “Map Panel” then click the “Zoom All” button under the ribbon; the map will zoom out to the total coverage area 

of the map 
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2. Zoom into the desired map location by using the scroll wheel on the mouse or the “Zoom In” button located under the 

ribbon 
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Creating, Loading and Assigning Vehicles to Routes 
INEXA Control provides multiple methods to load and manage routes. From the Map Panel, operators can quickly and easily create 

new routes, and load and assign a vehicle to a route. To create and assign a vehicle to a route, perform the following steps: 

1. From the Map Panel, select the Draw Route option from the Routes menu group.

2. From the Create Route panel, input a name in the Name field and press Enter. 

Note: When inputting data into an input field, INEXA Control will highlight the field in orange to indicate new or changed 

information. For each field, you must press the <Enter> button to submit the new or changed information. Once the <Enter> button 

is pressed, the orange highlight will revert back to a white input box. 

3. Enter an altitude for the route within the Altitude field and press Enter. 

4. Enter an airspeed for the route within the Speed field and press Enter. 

5. Select the Accept button to save the input and begin creating the route. 

 

Note: Once the Accept button is selected, the mouse icon will convert to a white triangle. 
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6. Position the mouse pointer over the location where the first route waypoint will be created and press the left Mouse-Click 

button. 

7. Continue adding additional route waypoints by repositioning the mouse over the map and pressing the left Mouse-Click 

button until all route waypoints have been created. 

8. After placing the final waypoint, select the <Esc> key on the keyboard. 

 

Note:  As in the example displayed above, the newly created route will appear in orange.  Once the route has been committed by 

the user, the route color may momentarily change to magenta indicating that the new route is pending an acknowledgement from 

the vehicle.  Once the vehicle has received and acknowledged the update, the route color will change to blue. 

Route Color Scheme: 

Orange – New input or change that has not been uploaded to a vehicle 

Magenta – New input or change committed by the user but not yet acknowledged by the vehicle 

Blue – Vehicle has accepted and acknowledged the change 
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9. To submit the route to the aircraft, right-mouse-click on one of the route waypoints and then, 

10. Select the Template Flight Planning option. 

11. From the Template Flight Planning menu select the Route: Upload to ArduCopter #n option. 

 

Note: Additional options to move, create, delete, modify, or discard route changes are available within the Template Flight Planning 

menu or through the Mission Planning menu, Route Editor option. 
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12. To assign the vehicle to the route, position the mouse over the vehicle, then click and drag the vehicle to the desired route 

waypoint. 

13. Once the mouse button is released, select the Direc AC #n o ‘wapoin number’ menu option. 

 

Note: The vehicle can be directed to any of the route waypoints. Once at the waypoint, the vehicle will begin navigating to the next 

waypoint. 
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Altitude Profile Display 
INEXA Control provides functionality that displays altitude profile information for the immediate area surrounding the vehicle. This 

information is particularly useful when operating vehicles in areas with varying terrain. To activate the Altitude Profile display, 

perform the following steps: 

1. From the Map Panel, select the Altitude Profile option within the Routes menu group. 
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Pan and Zoom Map Focus 
INEXA Control provides functionality that allows an operator to quickly adjust map focus. To adjust the map focus, perform one of 

the following steps: 

1. Pan – By default, the Pan option is always available within the Map Panel. To pan the map focus, mouse-click and hold the 

mouse at any position on the map, then move the mouse in any direction. The map will reposition to the new location. 

2. Drag Zoom – Click on the Drag Zoom option and then mouse-click and hold the mouse on an area of the map while 

dragging the mouse to another area on the map. When the mouse button is released, the map will refocus to fill the 

selected area within the Map Panel. 

3. Zoom In – Click on the Zoom In option to zoom in the map focus. 

4. Zoom Out – Click on the Zoom Out option to zoom out the map focus. 

5. Zoom All – Click on the Zoom All option to zoom out to the global map or to the extents of the activated Map Pack. 
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Map Overlays – Unsafe Elevation 
INEXA Control includes automated functionality that activates an unsafe elevation warning system whenever a vehicle comes within 

a prescribed time-to-impact or is at an elevation where the vehicle could or will impact with the terrain. When activated, this system 

provides operators with audio and visual alerts so the operator can take action to avoid collision with nearby terrain. INEXA Control 

also activates the system whenever the operator manually adjusts altitude settings to warn the operator if there are any areas 

where the vehicle may impact terrain based on the new settings. If needed, the operator can manually activate the system. This 

feature is particularly useful when planning routes through areas with varying terrain. 

To activate the Unsafe Elevation feature, perform the following steps: 

1. Within the Map Panel, Overlays menu group, select the Unsafe Elevation option. 

Note: For a better view of the surrounding map area, scroll out the map focus using the Zoom Out option in the Map Panel, Pan & 

Zoom menu group. Any area identified with a yellow overlay is a “caution” area. Any area identified with a red overlay is a “warning” 

area. It is your responsibility to operate your vehicle in a safe and professional manner. 
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Map Overlays – Breadcrumbs 
INEXA Control provides functionality that allows operators to generate an electronic trail of the area(s) where the vehicle has 

navigated. To manage Breadcrumbs, perform the following steps: 

1. Within the Map Panel, Overlays menu group, select the Breadcrumbs option. 

2. Reposition the vehicle to a new location. 

3. Select the Delete Breadcrumbs option to clear breadcrumbs. 

Note: To turn off breadcrumbs, click on the Breadcrumbs option. 
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Map Overlays – Sensor Point of Interest (SPOI) 
INEXA Control provides functionality that allows an operator to easily identify where the vehicle’s sensor is pointing and the scope of 

the sensor’s coverage. To activate the SPOI and the SPOI Footprint, perform the following steps: 

1. Within the Map Panel, Overlays menu group, select the SPOI option. 

2. Within the Map Panel, Overlays menu group, select the SPOI Footprint option. 
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Map Overlays – Point of Interest Labels 
INEXA Control provides automated functionality that displays pop-up label information whenever a cursor is positioned over a point 

of interest. Operators may also turn on Point Labels in order to quickly identify a specific point of interest in areas where multiple 

points of interest may exist. To activate Point Labels, perform the following steps: 

1. Within the Map Panel, Overlays menu group, select the Point Labels option. 
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Map Overlays – Estimated Time Enroute 
INEXA Control provides functionality to estimate the time required to navigate to a specified location. To enable ETE functionality, 

perform the following steps: 

1. Within the Map Panel, Overlays menu group, select the ETE option. 

2. Reposition the vehicle to a new location. 

Note: The estimated time enroute will display in the vehicle’s label information. 
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Map Overlays – Wind Flags 
INEXA Control provides functionality to display and manage wind information on the Map Panel if the vehicle has the necessary 

hardware to report wind information. To display and clear wind flag information, perform the following steps: 

1. Within the Map Panel, Overlays menu group, select the Wind Flags option. 

2. To clear wind flag information, select the Clear Wind Flags option. 

Note: The Unmanned Vehicle Plug-in for ArduCopter Simulation does not currently simulate wind information.  No wind information 

will display within the simulator or during vehicle operation unless the vehicle has the necessary hardware to report this information 

in live flight environments.  
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Map Overlays – Antenna Beams 
INEXA Control provides functionality to track antenna beams from directional antennas that may be used with the system. Tracking 

and displaying antenna beams is important for managing vehicle communications as directional antenna typically need to “unwind” 

if the vehicle has been navigating in areas that circle around the stationary antenna. To display Antenna Beams, perform the 

following steps: 

1. Within the Map Panel, Overlays menu group, select the Antenna Beams option. 

Note: The Unmanned Vehicle Plug-in for ArduCopter Simulation does not currently simulate antenna beam display functionality. No 

directional antenna beam information will display within the simulator or during vehicle operation unless the necessary hardware to 

report this information is available in live flight environments. 
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Map Overlays – Geofence 
INEXA Control provides functionality that allows an operator to establish a virtual fence at a specified altitude, distance or both 

around the Home Location (vehicle launch location).  If, during operations, the vehicle goes beyond the Geofence boundary or loses 

radio communications, the vehicle should return to the home location if the feature is enabled and if the vehicle supports this 

functionality.  To activate and configure Geofence functionality, perform the following steps: 

1. Within the Map Panel, Overlays menu group, select the Geofence option. 

Note: The Geofence will appear as a hashed red annotation that circles the vehicle’s Home Location. 
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2. Select the Mission Planning menu. 

3. Within the Limits menu group, select the Mission Limits option. 

4. In the Mission Limits panel, adjust the other Geofence settings as desired; leaving Type set as “DianceAliue”. 

Note: There are two (2) Geofence Type settings, Distance and Altitude.  If the vehicle altitude is set higher than the Geofence 

Altitude setting when Geofence is set to Enabled, and the Geofence Type is set to “DianceAliue”, then the vehicle will

automatically begin returning to the Home Location, regardless of the vehicle’s location on the map. 

5. In the Mission Limits panel, change the default Enabled status from Disabled to Enabled. 

Geofence Test Option 1 

6a. Mouse-click and hold the cursor over the vehicle while dragging the vehicle outside of the Geofence area, and then release 

the mouse-click to assign the vehicle to a new hover location. 

Geofence Test Option 2 

6b. Mouse-click on the Altitude Slider on the Flight Control Panel and drag the slider up to an altitude greater than the altitude 

limit set in the Mission Limits, Geofence settings menu. 

Note: Once the vehicle exceeds the Geofence distance or altitude settings, then the vehicle will be reassigned back to the Home 

Location, where it will be “recovered”. 

Note: To convert the Geofence measurements into feet, go to the Settings menu, Units option and change Ranges to “feet”. 
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Map Overlays – Declutter 
INEXA Control provides functionality that allows operators to declutter the Map Panel by minimizing the amount of information that 

is displayed on the screen. To manage vehicle, SPOI, and Route information displayed on the Map Panel, perform the following 

steps: 

1. Within the Map Panel, Overlays menu group, select the Declutter option. 

2. Adjust the Declutter display settings as desired. 

 

Declutter label management options include: 

 Selected Vehicle Labels 

 Non-Selected Vehicle Labels 

 Sensor Point of Interest (SPOI) 

 Contingency Routes 
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Map Overlays – Annotations 
INEXA Control provides functionality that allows operators to identify important operational areas, boundaries, and borders on the 

map and video panels. To create and manage annotations in the Map Panel, perform the following steps: 

1. Within the Map Panel, Overlays menu group, select the Annotations option. 

2. Within the Annotations menu, select the Edit button. 

Note: After selecting the Edit button, the name of the button will change to Lock. 

3. Give the Layer field a name and press the <Enter> key on the keyboard to accept the change. 

4. Within the Map Panel, Overlays menu group, select the Draw Polygon option. 

5. Position the mouse over the area where the polygon will be created and mouse-click to set the first point for the polygon. 

6. Repeat Step 5 until the entire border for the polygon has been created then press the <Esc> key on the keyboard. 

7. Give the polygon a name and press the <Enter> key on the keyboard to accept the change. 

Note: Similar steps can be performed to create Draw Ellipse and Draw Freeform annotations. 

Note: Click on the Lock button when edits are complete to eliminate the risk of inadvertent changes. Additional Layers may be 

created and are useful when managing annotations for different map areas. Additional functionality is available to adjust the border, 

border fill area, and annotation text by clicking on the Border and Fill options on the Polygon menu tabs. 
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Map Overlays – Shapefiles 
INEXA Control provides functionality to import Shapefiles into the application. To import Shapefiles, perform the following steps: 

1. Within the Map Panel, Overlays menu group, select the Shapefile option. 

2. In the Shapefiles menu, select the +Shapefile button. 

 

3. In the Open windows screen, select an available shapefile option and then select Open. 
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Map Panel Settings – Auto Follow 
INEXA Control provides functionality that automatically repositions the map if the active vehicle travels off of the viewable map 

area. To activate Auto Follow, perform the following steps: 

1. Within the Map Panel, Settings menu group, select the Auto Follow option. 

Note: To test the Auto Follow functionality, mouse-click on the map and reposition the map so that the active vehicle is not 

viewable. Upon releasing the mouse button, the map will reposition so that the vehicle is viewable. 
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Map Panel Settings – Dim 
INEXA Control provides functionality to dim the map panel for low light environments. To activate this feature, perform the 

following steps: 

1. Within the Map Panel, Settings menu group, select the Dim option. 
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Map Panel Settings – Map 
INEXA Control provides functionality that allows an operator to specify Mouse Wheel Zoom, Inactive Symbol Opacity, and Maritime 

DTED map related settings. To manage this functionality, perform the following steps: 

1. Within the Map Panel, Settings menu group, select the Map option. 

2. Specify whether Mouse Wheel Zoom functionality is being performed using a Trackball or Standard Mouse. 

3. Specify the Inactive Symbol Opacity percentage for non-active vehicle(s). 

Note: INEXA Control allows multiple instances of INEXA Control to be installed and operational on the same network at the 

same time. For INEXA Control systems that are configured to support multiple vehicle and payload control, INEXA Control 

provides opacity control functionality that diminishes or hides Map Symbols that are associated with inactive vehicles. 

4. Specify the Maritime DTED Reference Height in meters above sea level. 

Note: Map files lack DTED (Digital Terrain Elevation Data) for marine environments making it 

difficult to determine the altitude of a vehicle over water.  The maritime DTED Reference Height 

setting allows an operator to approximate DTED when no terrain information can be referenced 

from the map. The traditional, orthometric height (H) is the height above an imaginary surface 

called the geoid, which is determined by the earth’s gravity and approximated by MSL. The signed 

difference between the two heights, the difference between the ellipsoid and geoid, is the geoid 

height (N). 
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Home Menu Management 

Network Explorer 
INEXA Control provides access to components on the network through the Network Explorer control. To view and manage network

components, perform the following steps: 

1. Select the Home menu option. 

2. From within the Home menu, select the Network Explorer option. 

3. Select individual hardware components within the network to view status information and to access control options. 

 

Note: Take, Release and Override options found within Network Explorer allow the operator to take or release control of individual 

hardware components. When operating within a multi-vehicle, multi-payload networked INEXA Control environment, these controls 

allow operators to pass vehicle or payload control between stations by overriding and taking control from another operator. 
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Operational Procedures – Normal Procedures 
INEXA Control provides functionality to display Normal Procedures for normal operational tasks. INEXA Control also supports 

functionality to execute tasks listed within procedure lists directly from the Normal Procedures menu; versus navigating through 

menus to perform the same tasks.  

Note:  INEXA Control uses custom electronic checklists to meet operator needs; please contact Insitu Customer Support for more 

information. 

To access available normal procedures lists, perform the following steps: 

1. Within the Home menu, select the Normal Procedures option. 

2. Within the Normal Procedures menu list, select an available procedures list to start. 

 

Note: Procedures lists are created outside of the INEXA Control software and must be imported to be available for selection. Select 

the Lock icon to unlock in-progress or completed procedures, and then select the Remove All option to remove all lists. 
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Operational Procedures – Emergency Procedures 
INEXA Control provides functionality to display Emergency Procedures for urgent tasks that must be performed in emergency 

situations. INEXA Control monitors system messages for critical or emergency situations that may occur during operations. When 

encountered, INEXA Control will prompt the operator with visual and audio system warning messages so that the operator can take 

action to resolve the problem. INEXA Control can also display emergency recovery procedures that the operator can perform to 

resolve emergency situations. If installed, emergency procedures will automatically appear when an associated emergency situation 

is encountered.  

Note:  INEXA Control uses custom electronic checklists to meet operator needs; please contact Insitu Customer Support for more 

information. 

To manually access available emergency procedures lists, perform the following steps: 

1. Within the Home menu, select the Emergency Procedures option. 

 

Note:  Procedure lists are created outside of the INEXA Control software and must be imported to be available for selection.  
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Operational Procedures – Manage Procedures 
INEXA Control provides functionality to import and manage procedural checklists.  

Note:  INEXA Control uses custom electronic checklists to meet operator needs; please contact Insitu Customer Support for more 

information. 

To access the Manage Procedures options, perform the following steps: 

1. Within the Home menu, select the Manage Procedures option. 
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Display Panel Management 

Quick Grid Displays 
INEXA Control supports combining application display panels to a display grid so that information from all panels is accessible at the 

same time. To format all active displays into a single grid display, perform the following steps: 

1. Within the Home menu, select the Quick Grid menu option. 
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Tabbed Displays 
To revert back to the standard multi-layered tabbed displays, perform the following steps: 

1. Double-click on one of the available display tabs (e.g. Map, Tracker, Video). 
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Manual Display Grid 
INEXA Control provides functionality to manually configure display formats. To manually create a display grid, perform the following 

steps: 

1. Mouse-click and hold on a display panel tab. 

2. Drag the tab to the center of the screen and select a position for the display on the grid. 

Note: Manual display grid options are combined, top, right, bottom, or left. 

 

Note: INEXA Control also supports displaying different display panels (e.g. Map, Tracker, or Video) on separate screens.  To move a 

display panel to a separate screen, click on the display tab and drag the display to a different screen. 
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Toggle Full Screen 
INEXA Control provides functionality to toggle in and out of full-screen viewing mode. To toggle in and out of full screen mode, 

perform the following steps: 

1. From within the Home menu option, select the Toggle Full Screen option. 

Note: The F11 function key will also toggle in and out of full screen mode. 
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Add a Display 
INEXA Control provides functionality to add additional display panels. This functionality is beneficial when operating multiple 

vehicles and payloads from a single INEXA Control station or when working within a networked environment. To add new display 

panels, perform the following steps: 

1. Within the Home menu, select the Add Display option. 

2. Within the Add Display list select a display option. 

3. Select the new display panel. 

Note: Only one Map Display is available per INEXA Control station. New displays will appear in the tabbed display panel. 
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User Feedback 
INEXA Control provides functionality for operators to send feedback and defect reports with screen captures to Insitu. To send 

feedback or defect reports to Insitu, perform the following steps: 

1. Within the Home menu, select the User Feedback option. 

2. Within the Feedback screen, select the feedback type. 

3. Complete the required feedback information fields and select Send Report. 

Note: This feature requires Internet connectivity. 
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Reset Workspace 
INEXA Control provides functionality to reset the application workspace back to the default configuration. To reset the application 

workspace, perform the following steps: 

1. Within the Home menu, select the Reset Workspace option. 
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Mission Planning Menu 

Points of Interest Management 

Create Point of Interest 
INEXA Control provides functionality to create and manage Points of Interest.  To add and manage new Points of Interest, perform 

the following steps: 

1. Within the Mission Planning, Points menu group, select the Points of Interest menu option.  From the Points of Interest 

menu option, select the +Point button to add a new Point of Interest on the map.

Note: A blue pin will appear on the map. 

2. Mouse-click on the blue pin and drag the new Point of Interest to the appropriate location on the map.

3. On the Details tab in the Points of Interest menu, input a Name for the new Point of Interest. 

4. In the Type field, select an appropriate icon that best represents the Point of Interest. 

5. Uncheck the Expires checkbox, or specify an expiration time for the Point of Interest. 

 

Note: To delete an individual Point of Interest select the point of interest and then select the –Point button. Select –Remove All to 

delete all Points of Interest. Click on the Location and Direction tabs to adjust location and range/bearing and speed/direction 

information. 
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Camera Control (Slew to Point of Interest) 
To direct payloads to monitor specific points of interest using vehicle payload control, perform the following steps: 

Note: This tutorial assumes that Points of Interest have already been created. 

1. Within the Mission Planning, Points menu group, select the Points of Interest menu option. 

2. Within the Command Aircraft menu section, select an available payload then, 

3. Select an available Point of Interest. 

4. Select the Slew button. 
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Alternate Camera Control (Slew to Point of Interest) 
INEXA Control provides camera control functionality to quickly direct a payload to monitor an existing Point of Interest from the 

Map Panel without navigating through menus. To slew a payload to an existing Point of Interest directly from the Map Panel, 

perform the following steps: 

1. From the Map Panel, hover the mouse pointer over an existing Point of Interest and right-click the mouse button. 

Note: INEXA Control will highlight the Point of Interest in blue when the mouse pointer is positioned over the Point of Interest. 

2. Hover the mouse pointer over the Payload: Slew Here option then, 

3. Select Slew Saion… option (selecting the appropriate station to slew to the Point of Interest). 
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Route Editor – Overview 
The INEXA Control Route Editor is a convenient tool for managing routes. The tool provides functionality to manage vehicle route 

assignments, upload and download routes and route changes to vehicles, and import and export routes between INEXA Control 

systems. 

Note: The Unmanned Vehicle Plug-in for ArduCopter supports a limited number of routes uploaded to the vehicle at one time. The 

Home route is the vehicle launch and recovery location. If Geofence is enabled, the vehicle will return to the Home route if it ever 

goes beyond the distance or altitude limits set within the Geofence. This feature reduces the risk of lost or damaged equipment due 

to lost communications or flyaway scenarios. Although only one additional route may be uploaded to the ArduCopter vehicle at one 

time, any number of unassigned routes may be created and managed in the Route Editor. 

To create and manage routes using the Route Editor, perform the following steps: 

1. Within the Mission Planning, Routes menu group, select the Route Editor. 

2. Expand the Routes for ArduCopter #n option and then, 

3. Expand the Home route option. 

4. In the Route Properties menu section, explore the route options. 
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Route Editor – Creating and Managing New Routes 
INEXA Control provides the functionality to create and manage new routes from the Route Editor menu. To create and manage 

routes using the Route Editor, perform the following steps: 

1. Within the Route Editor, select the +Route option. 

2. Give the route a Name. 

3. Specify the route Altitude. 

4. Specify the route Speed. 

5. Select the Accept button. 

 

Note: Upon completing Step 5 above, the Route Editor will generate the first two route waypoints. The route will be orange, 

indicating that the route is a new change that has not been uploaded to the vehicle. 
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6. Expand the Unassigned Routes route option, and then expand the newly created route.

7. Reposition the first route waypoint to the beginning point for the route. 

8. Reposition the second route waypoint to the second point for the route. 

9. Select the last waypoint under Unassigned Routes and click on the +Waypoint button to add an additional waypoint. 

10. Reposition the newly added waypoint and then repeat steps 9 and 10 until the route is complete. 

11. Select Upload All Changes.

 

Note: Once the Upload All Changes button has been selected, the route color will change from orange to blue, indicating that the 

route changes have been uploaded to the vehicle and the vehicle has acknowledged the changes. Also, the route will move from the 

Unassigned Routes (Templates) to the Routes for ArduCopter #n list. 
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Route Editor – Discarding Route Changes 
INEXA Control provides functionality to discard unwanted route changes. To discard unwanted changes, perform the following steps: 

1. With the mouse, click and hold the mouse button on an existing waypoint and move the waypoint to a new location. 

Note: The waypoint color will change to orange indicating a change that has not been uploaded to the vehicle. 

2. Select the Discard Route Changes button. 

Note: When the Discard Route Changes button is selected, all pending route changes are discarded. 
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Route Editor – Modifying Waypoint Actions 
INEXA Control provides route management functionality that allows an operator to specify specific actions the vehicle should take 

upon reaching a specified route waypoint. To manage waypoint actions, perform the following steps: 

1. Select a route waypoint in the Routes for ArduCopter #n assigned routes. 

2. In the Waypoint Properties select the Actions dropdown box and select the Payload option. 

3. Select the +Action button. 

4. On the waypoint, select and move the newly created Starepoint crosshair to a new location. 

5. Select the Upload All Changes button to save and upload changes to the vehicle. 

6. Assign the vehicle to the route. 

Note: Route Actions include Loiter, Payload, Airframe, and Vehicle Specific actions. When the vehicle reaches the assigned 

waypoint, the vehicle will fulfill the assigned task(s) associated with that waypoint. 
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Route Management – Importing and Exporting Routes 
INEXA Control provides functionality to import and export routes for use in other INEXA Control stations or for archiving and future 

use. To import and export routes, perform the following steps: 

1. In the Route Editor, Import/Export Routes section, expand the Routes for ArduCopter #n option. 

2. Select one or more routes for export. 

3. Select the Export button. 

 

4. In the Save As window, give the route file a name then, 

5. Select the Save button. 

 

Note: The route will be saved to the specified directory. 
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To import a previously saved route, perform the following steps: 

1. In the Route Editor, Import/Export Routes section, select the Import routes option. 

 

2. In the Open window, locate and select the previously exported route. 

3. Select the Open button. 

 

Note: The route will load into the Route Manager and appear in the Unassigned Routes (Template) list. Select Upload All Changes 

to save the imported route. 
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Mission Limits 
INEXA Control provides functionality to set operational limits relating to altitude, actions that should be taken with the vehicle when 

it goes beyond set limits, or actions to take when communications with a vehicle are lost.  

Setting Altitude Limits 
To configure vehicle altitude limits, perform the following steps: 

1. Within the Mission Planning, Limits menu group, select the Mission Limits option. 

2. Within the Settings, Mission Limits menu section, select the Maximum Altitude configuration gear icon. 

3. Input a Maximum Altitude value. 

Note: The Maximum Altitude value should be a value less than 18,000 feet MSL. 

4. Select the Minimum Altitude configuration gear icon. 

5. Input a Minimum Altitude value. 

Note: The Minimum Altitude value should be a value greater than -2,000 feet MSL.
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Setting Geofence Limits 
To configure Geofence vehicle boundary and maximum altitude limits, perform the following steps: 

1. Within the Settings, Geofence menu section, select the Enabled configuration gear icon. 

2. Select either the Enabled or the Disabled button. 

3. Select the Type configuration gear icon. 

4. Specify whether the Geofence is applicable to Altitude, Distance, or both Distance/Altitude. 

5. Select the Distance configuration gear icon. 

6. Specify the Distance (size of the Geofence). 

Note: The distance or size of the Geofence is measured from the Home launch location as the center point of the Geofence out 

to the point specified in the Distance field and is represented as a hashed circle around the launch location on the Map Panel. 

See the Map Overlays – Geofence section for more information regarding the implementation and use of Geofence. 
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7. Select the Altitude configuration gear icon. 

8. Specify the Altitude (maximum altitude of the Geofence). 

9. Select the Margin configuration gear icon. 

10. Specify the Margin (relative margin of error based on GPS accuracy). 

11. Select the Action configuration gear icon. 

12. Specify the Action to take when the Geofence limits are exceeded.
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Lost Communications Action 
To configure actions that will take place when communications with the vehicle are lost, perform these steps: 

1. Within the Settings, Lost Communications menu section, select the Behavior configuration gear icon. 

2. Specify whether the vehicle will Return to Launch or be Disabled if communications with the vehicle are lost. 
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Mission Execution 

Launch and Recovery
INEXA Control provides functionality to manually launch and recover vehicles. To launch the vehicle manually, perform the following 

steps: 

1. Select the Home menu option then, 

2. Select Network Explorer to display the Network Explorer panel. 
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3. Select the Training tab located in the main application menu. 

4. Select the Aircraft icon located in the lower left-hand corner of the flight control panel. 

5. Select the Start button.  Wait for the simulation to start and the aircraft status to go green. 

6. In the Network Explorer panel, select the vehicle. 

7. Select the Launch/Recover gear icon to expose the control option buttons. 

8. Take Launch/Recover control by selecting the Take button.
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9. From the Mission Execution tab, select Launch Recover to display the Launch/Recovery panel. 

10. Select the Launch Altitude gear icon to expose the Launch Altitude input field. 

11. In the Launch/Recovery panel, set the Launch Altitude (e.g. 400 ft.) and press <Enter>. 

12. Select the yellow and black header to unlock the Launch/Recover Command control. 

13. Select the Launch button. 
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Aircraft Systems 

Transponder 
INEXA Control provides functionality to view and manage the transponder if the vehicle is equipped with the necessary hardware. To 

manage the transponder, perform the following steps: 

1. Select the Mission Execution menu tab. 

2. Within the Aircraft Systems menu group, select the Transponder option to view and manage transponder controls. 
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Electrical Panel 
If the vehicle and the vehicle plugin provide operator controls for turning on and off electrical sub-systems, those systems will be 

accessible inside the Electrical Panel within the Aircraft Systems menu group. To access electric controls for aircraft sub-systems, 

perform the following steps: 

1. Within the Aircraft Systems menu group, select the Electrical control option. 

Note: The electrical control panel will display any electronic control systems made available through the vehicle plugin and INEXA 

Control. 
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Lights 
If the vehicle and the Vehicle Specific Module (VSM) (vehicle plugin) provide operator controls for turning on and off lights, the 

lighting controls will be accessible inside the Lights Panel within the Aircraft Systems menu group. To access lighting controls, 

perform the following steps: 

1. Within the Aircraft Systems menu group, select the Lights control option. 
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Engine Gauges 
Additional operational gauges may be available for display within INEXA Control. To display optional operational gauges, perform the 

following steps: 

1. Within the Aircraft Systems menu group, select the Gauges control option. 

Note: The gauges control panel will display any optional operational gauges. 
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Environmental Conditions 
INEXA Control provides functionality to monitor the static air pressure, wind speed and wind direction surrounding the vehicle, 

provided that the necessary communications and diagnostics hardware is available on the vehicle. To access environmental 

condition information, perform the following steps: 

1. Within the Aircraft Systems menu group, select the Environment control option. 
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Laser Controls 
INEXA Control provides functionality to control and manage the vehicle’s laser range finder and marker functions if the necessary 

communications and vehicle hardware are available. To control and manage the vehicle’s laser range finder and marker functions, 

perform the following steps: 

1. Within the Aircraft Systems menu group, select the Laser control option. 

2. From within the Arm and Activate menu panel, select the yellow and black header to access the laser arm and disarm 

controls. 

3. Select the Range or Mark options as applicable. 

Note: Additional laser arming functionality is available within the Tracker Panel, Lasers menu group.
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Mission Management

Mission ID 
INEXA Control provides functionality to manage and control mission ID information, if supported by the vehicle. To manage and 

control mission ID information, perform the following steps: 

1. Within the Mission menu group, select the Mission ID control option. 

2. Within the Mission ID control panel, select the Edit Settings option. 

Note: Setting changes may take up to a minute to be reported. Functionality requires the vehicle’s ability to report. 
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3. Input the necessary information within the Mission ID and Security Settings sections. 

4. Select the Edit Settings option to exit editing mode. 

 

 



© 2017 Insitu Inc., All Rights Reserved Page 101 Insitu Proprietary 
 

Chat 
INEXA Control provides functionality that allows operators from multiple INEXA Control stations on the same network to text chat 

between stations. To access Chat functionality, perform the following steps: 

1. Within the Mission menu group, select the Chat control option. 

2. Within the Chat panel, input a message within the Message input box. 

3. Select the Send button to send the chat message. 

Note: The INEXA Control station must be on a network and configured to support a multi-station environment for the chat 

functionality to be active. 
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Information Management Tools 

Location Tools 
INEXA Control provides tools to quickly display the vehicle, selected point of interest, and Sensor Point of Interest (SPOI) positions. 

To view location information, perform the following steps: 

1. Within the Mission Execution, Tools menu group, select the Location option. 
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Video Metadata Viewer 
INEXA Control provides functionality to display video metadata encoded in a video stream from an active payload station. To display 

video metadata, perform the following steps: 

1. Within the Mission Execution, Tools menu group, select the Video Metadata Viewer option. 

2. Select an active payload or a user defined payload station. 

3. To select specific metadata elements to watch, click on the metadata element then, 

4. Select the +Watch button. 

5. Select Clear Watches to clear the metadata watch list. 
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Message History 
INEXA Control provides functionality to display system message history information. To view message history, perform the following 

steps: 

1. Within the Mission Execution, Tools menu group, select the Message History option. 
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Training Menu 

Simulation Controls – Quick Launch 
INEXA Control includes a built in simulation system that is useful for mission planning and training purposes. To Quick Launch a

simulated vehicle, perform the following steps: 

1. Select the Training Tab located in the main application menu. 

2. Select the Aircraft icon located in the lower left-hand corner of the flight control panel. 

3. Select the Quick Launch button. 
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Simulation Panels – Settings (Simulator Launch Location Settings) 
INEXA Control provides functionality that allows operators to move the built in simulation system launch location to any other 

location on the map. To move the launch location, perform the following steps: 

1. If INEXA Control is running, close and restart the application. Otherwise, start the INEXA Control application. 

2. Select the Training tab menu option. 

3. Select the vehicle icon located in the lower-left corner of the application. 

4. Select the Settings option located in the Simulation Panels menu group. 

5. Position the mouse pointer over the area of the map where the new launch location will be located. 

6. Record on a piece of paper the DTED, latitude, and longitude of the new launch location. 

7. In the Settings menu screen, input a Name for the new launch location. 

8. Select the radial button to open the Location settings panel. 
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9. On the Location tab of the Location settings panel, input the new Latitude, Longitude, and Altitude for the new launch 

location. 

Note: The Altitude setting value should be 2 – 5 feet greater than the DTED recorded for the new launch location. If the Altitude 

is entered using the actual DTED value, then the simulated vehicle will not launch successfully. 

Note: When entering in new values into any input field within INEXA Control, it is important to press the <Enter> key on the 

keyboard for each updated field in order to save the change. 

10. Set the Quick Launch Altitude to 50-feet greater than the DTED value. For example, if the DTED value for the new launch 

location is 77-feet then the Quick Launch Altitude should be 127-feet. 

11. Select the Quick Launch button within the Simulation Controls menu group to launch the vehicle from the new launch 

location. 

 



© 2017 Insitu Inc., All Rights Reserved Page 108 Insitu Proprietary 
 

Scene Designer – Scenario Designer 
INEXA Control provides a basic scene generator that allows an operator to generate simulated vehicles that follow operator defined 

paths and are viewable from INEXA Control Tracker and Video screens. To activate vehicles running on simulation routes within 

INEXA Control, perform the following steps: 

1. Within the Training, Scene Designer menu group, select the Scenario Designer option. 

2. Within the Scenario Designer, Paths menu section, select an available path option. 

3. Within the Parameters menu section, select a vehicle Model, and set the Speed and Altitude (if applicable).

4. Press Start. 

Note: Each time the Start button is pressed, a new simulated vehicle will be generated. Wait a second or more between pressing 

Start to ensure simulated vehicles are not generated over the top of each other. Multiple vehicle types may be generated on the 

same route. In order to generate simulated vehicles, a Tracker Panel, Payload Station must be active. 

 

Note: A tutorial on creating and installing new paths that simulated vehicles travel is covered in the Miscellaneous Functionality – 

Simulation System Scenario Designer section. 
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Scene Designer – Simulated Vehicles 
The following is an example of the simulated vehicles available in the INEXA Control simulation system. 

 
 



© 2017 Insitu Inc., All Rights Reserved Page 110 Insitu Proprietary 
 

Settings Menu 

Application Settings – Units 
INEXA Control provides functionality that allows an operator to change measurement settings to accommodate regional or

operational requirements. To adjust Units of measurement in INEXA Control, perform the following steps: 

1. Within the Settings, Application Settings menu group, select the Units option. 

2. In the Units menu: 

a. Specify how Coordinates are displayed. 

b. Specify how Ranges are measured. 

c. Specify how Headings are displayed. 

d. Specify how Altimeter Settings are displayed. 

  

 



© 2017 Insitu Inc., All Rights Reserved Page 111 Insitu Proprietary 
 

Application Settings – Terrain Warning 
INEXA Control includes an embedded Terrain Warning system that automatically alerts an operator when a vehicle may or has 

entered an area where the vehicle could impact the terrain.  The system will also activate momentarily whenever an operator 

changes a vehicle’s altitude setting.  An operator may also manually turn on the warning system (see Map Overlays – Unsafe 

Elevation) during flight operations or when planning routes and missions.  To adjust when the Terrain Warning visual and audio 

alerts will be activated, perform the following steps: 

1. Within the Settings menu in the Application Settings group, select the Terrain Warning option. 

2. In the Terrain Warning menu under the Display group of input fields, input new Yellow Caution and Red Warning AGL 

warning altitudes. 

Note: When changing the caution and warning settings, always set the Red Warning setting first.  Also, the separation between 

the two warning levels must be at least 50 feet. 

 

Note: The Terrain Warning system also includes a time or distance to impact warning alarm. The default setting for this alarm is 45 

seconds. 
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Application Settings – Points of Interest 
INEXA Control provides functionality to configure labeling, expiration, and notifications for new Points of Interest identified during 

operations. To configure Points of Interest, perform the following steps: 

1. Within the Settings menu in the Application Settings group, select the Points of Interest option. 

2. In the Points of Interest, New Points menu section, specify the Prefix label that will be used with each new point of interest 

and the number of Digits for ID. 

3. If Points of Interest will have an expiration time period, specify the Expiration time period. 

Note: Valid Expiration time periods are defined in Hour or Day periods (e.g. “1 Hour” or “3 Days”). 

4. Associate a sound that the system should play whenever a Point of Interest is created, tasks are assigned, or any time a 

Point of Interest is changed. 
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Application Settings – Video Sources 
INEXA Control provides integration with industry standard video formats and can process video coming from vehicle payloads or 

from other sources not directly associated with unmanned vehicle operations. To link to other Video Sources, perform the following 

steps: 

1. Within the Settings, Application Settings menu group, select the Video Sources option. 

2. Within the User Defined video sources menu, select the Add option. 

3. Provide a Name for the video source. 

4. Identify the Type of source location for the video source. 

Note: Valid video source Types include videos from Network, File, Capture Card, and RTSP. Also note that the input information 

required for each video source Type will vary depending on the Type selected. 

 

Note: Once identified, external video sources may be selected as a viewable video source following the instructions found in the 

Video Panel – Video Source Selection section. 
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Application Settings – Joystick 
INEXA Control is compatible with joystick integration for payload management provided that the necessary communications and 

gimbaled payload hardware is available. To link to Joystick hardware, perform the following steps: 

1. Within the Settings, Application Settings menu group, select the Joystick option. 

2. Within the Detected Joysticks menu option, select an available joystick. 

3. Give the joystick a name in the Nickname field and set the other joystick options as needed. 

Note: Check the Invert Look checkbox if the joystick steering direction is opposite of anticipated results. 
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Application Settings – Mission Data 
INEXA Control logs mission data in a specific file. Mission data may be copied from one INEXA Control system to another and is 

beneficial when configuring multiple INEXA Control systems that need the same mission data (e.g. annotations, imagery, shape files, 

and points of interest). To identify the Mission Data file location, perform the following steps: 

1. Within the Settings, Application Settings menu group, select the Mission Data option. 

Note: The Mission Data file location is:     C:\Program Files (x86)\Insitu\Inexa Control 2.1\ICOMC2\MissionData 
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Application Settings – Chat 
INEXA Control provides basic chat functionality that allows operators on multiple networked INEXA Control systems to send chat 

messages between stations. To configure Chat options, perform the following steps: 

1. Within the Settings, Application Settings menu group, select the Chat option. 

2. Specify whether to receive pop-up chats with audio alerts in the Notifications menu. 
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Application Settings – Hot Keys 
INEXA Control provides quick toggling to application options using Hot Keys. To turn on/off Hot Keys, perform the following steps: 

1. Within the Settings, Application Settings menu group, select the Hot Keys option. 

Note: Hot Keys quick menu options can be accessed using <Alt> + “Corresponding Hot Key”.  Example, “<Alt> + M” takes the 

operator to Mission Planning. 
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Application Settings – Reset Settings 
INEXA Control provides operators the ability to quickly reset INEXA Control settings to the default “factory installation” settings.  

Additional options allow operators to also quickly remove map data rather than removing maps one at a time using the Map Panel – 

Map Management option. To reset INEXA Control back to factory installation settings, perform the following steps: 

1. Within the Settings, Application Settings menu group, select the Reset Settings option. 

2. Select the appropriate Reset Settings option. 

Note: This option will reset all settings and clear out user-defined information. Prior to resetting the application, make a backup of 

the Mission Data folder if mission data will be reinstalled at a later date. To reinstall mission data, copy an archived Mission Data 

folder and contents over the top of the existing Mission Data folder. 
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Network Settings – Network Configuration 
INEXA Control is a STANAG 4586 standards compliant ground control application and is capable of communicating with multiple 

INEXA Control systems across different network nodes.  To configure multiple network channels, perform the following steps: 

1. Within the Settings, Network Settings menu group, select the Network Configuration option. 

2. Select the + Channel button. 

3. Input the necessary network information as required. 

Note: When setting up or removing multiple network channels, take note that at least one network channel must be selected as 

Active. Failure to have at least one network channel will result in the inability to communicate with any vehicles/hardware 

associated with that channel. 
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Plug-ins – Plug-in Status 
INEXA Control supports the addition of new features, functionality, sensors, other payloads, and vehicles through plugin 

applications. Installed plugin applications are available to be viewed, activated, or deactivated within the Settings menu. To view 

and activate or deactivate available plugin applications, perform the following steps: 

1. Within the Settings, Plug-ins menu group, select the Plug-in Status option. 

2. View plugins and select the corresponding checkbox option to activate or deactivate the plugin application. 
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Simulation System – Simulated Vehicle Route Creation 

Simulation System Scenario Designer 
The INEXA Control simulation system allows operators to generate simulated vehicle overlays over video imagery for use in mission

planning and product demonstrations.  Within the simulator, trucks and helicopters follow predefined .KML routes.  If the route is a 

point-to-point route, the vehicle will navigate the simulation route, disappear at the end of the route, and restart again at the 

beginning of the route.  If the route is a loop, the vehicle will continuously navigate the loop until the application is closed.  Routes 

can be created using publicly available applications like Google Earth.  Once a .KML route has been uploaded into the INEXA Control 

simulation system, simulated vehicles can be generated on the route. 

Creating a Simulation Route 
INEXA Control uses .KML files for Simulation Routes.  Please refer to Appendix B: Simulation Route Creation for creating a .KML 

Simulation Route in Google Earth Pro. 
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Loading Simulation Routes into INEXA Control 
To load a .kml simulation route file into the INEXA Control Scenario Designer, complete the following steps: 

1. If INEXA Control is not already running, start the application, launch an aircraft, and navigate to the Training menu. 

2. Within the Training menu, select Scenario Designer, then 

3. Select the +Scenario button. 
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4. Navigate to the directory where the newly created .KML file is located. 

5. Select the .KML file, and 

6. Select the Open button. 

 

Note: The simulation route is now in the Scenario Designer, Paths list and available for use in the simulator. 

Reminder: Until a video payload is activated in the Tracker Panel, no simulation routes can be activated in the Scenario Designer, 

Parameters options box. 
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Appendix 

Appendix A: Map Pack Creation 

Introduction 
This appendix section will guide you through creating a map pack for INEXA Control 2.1 & ICOMC2 2.1. INEXA Control & ICOMC2 use 

the ArcGIS Runtime for WPF 10.2.7.0 Map Engine, for more information, see www.esri.com 

Minimum Prerequisites 
 All map data must exist on, or be copied to a local hard disk.

 The ArcGIS Desktop 10.1 software must be installed. No other versions of software are compatible. 

Preparing Data 
In order to expedite the map pack creation process, it is recommended that you prepare your map data as follows: 

1. Create a directory and give it the same name as your map, for example 'Boardman + Arlington'.  This directory will be 

referred to as the map directory from this point on. 

2. Create an additional directory with the name ‘Intermediate Data’. Move all of the map data into this folder. You may 

choose to organize data into subfolders such as ‘DTED’ and ‘imagery’ within this folder. This directory will be referred to as 

the intermediate directory from this point on. 

Preparing ArcMap 
1. Start the ArcMap 10.1 application and close the 'Getting Started' window if it appears. 

Note: Steps 2-5 may be skipped if ArcMap has already been configured to create map packs 

2. Select the “Customize” menu from the top of ArcMap. 

3. Select “ArcMap Options…” 
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4. Under the “Sharing” tab, enable the checkbox titled “Enable ArcGIS Runtime Tools”. 

 
5. Click “Ok” 

6. Click 'File > New...' then choose 'Blank Map' and click 'OK'.  This will create an empty map package. 

7. Click 'File > Save As...' and navigate to the map directory.  Give your map a name and ensure it is saved as a '.mxd' file. 

 
8. From the top menu  in ArcMap choose 'Windows > Catalog' to bring up the 'Catalog' side panel. 

9. Right click on the 'Folder Connections' node and choose 'Connect Folder...'  

10. Select your intermediate directory in the dialog that appears and click 'OK' 
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11. In the 'Catalog' panel under 'Folder Connections' you should now see your map directory listed.   

12. Leave ArcMap running with your map pack open for the duration of the instructions. 

Formatting DTED (Elevation) Data 

ArcGIS supports a vast number of elevation formats.  However, in order to quickly process elevation in ICOMC2 it is required to 

convert these files to the '.flt' format.  This section will demonstrate how to convert elevation data and add it to your map. 

 

 

1. Click on the ‘Add Data’ button in ArcMap. This will bring up a new window. 

 
a. Select all the elevation data that you want to add to the map.  You can select multiple files at once by holding 

down 'Control' and clicking the files. Click 'Add' to add it to the list of files.

Note: If the folder(s) containing elevation data are not visible, click the “Connect to Folder” button and select the 

folder. 
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b. Click 'OK' to add the elevation data to the map.  This operation may take a while depending on the amount of data.  

You can view progress in the lower right area of ArcMap.  Do not attempt to continue until the operation 

completes. 

 

3. Once all of the elevation layers have been loaded, click “Windows>Image Analysis” at the top of ArcMap.

 
a. Select all of the elevation layers in the Image Analysis window by shift-clicking to multi-select. 

b. In the “Processing” section of the Image Analysis Window, select “Max” from the first dropdown below the color 

gradient. 

c. Click the button beside the “Max” dropdown that resembles two grids and a “+” sign. 

4. A new layer will have been added to the map that is a mosaic of the elevation datasets. 

a. Remove all of the original elevation datasets, leaving only the new mosaic, by right clicking them in the Table of 

Contents and selecting ‘Remove’. 
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5. Now export the new mosaic to .flt by navigating to the top menu and choosing 'Geoprocessing > ArcToolbox'.  From the 

'ArcToolbox' panel click 'Conversion Tools > From Raster' and double-click 'Raster to Float' 

 
6. A dialog box will open with two inputs. 

 
a. For 'Input Raster' use the dropdown to select the 'Elevation' layer you just created. 
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b. For 'Output floating point raster file' click the folder button and navigate to the map directory.  Enter the name 

'elevation.flt' and click 'OK'. 

 
c. Click 'OK' to convert the data.  Once complete, verify that 'elevation.flt' and 'elevation.hdr' have been created in 

your map directory. An additional file, ‘elevation.prj’, may also be present. (there may also be several other files 

with the same name and various extensions, such as *.xml or *.aux). 

 
7. In ArcMap, navigate to 'Windows > Table Of Contents' and remove all 'Elevation' layers. 
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Formatting & Adding Orthoimagery (Raster) Data 

Note that ArcMap should now have your map document opened, but with no layers. 

1. Navigate to the top menu of ArcMap and choose 'Geoprocessing > ArcToolbox'. 

2. Navigate to ‘Data Management>Raster’ and double-click on ‘Batch Calculate Statistics’ 

 
3. Within the new dialog, click the top most folder icon and select all of your imagery data from within your intermediate 

folder.  
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a. Click ‘OK’ to begin execution. This operation may take a while depending on the amount of data.  You can view 

progress in the lower right area of ArcMap.  Do not attempt to continue until the operation completes. 

 
 

 
4. Return to the top menu of ArcMap and choose 'Geoprocessing > ArcToolbox'. 
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5. Navigate to the ‘Add Data’ button at the top of ArcMap and add all of your raster imagery. 

6. From the top of ArcMap, select the ‘Windows’ menu and open ‘Image Analysis’  

7. From the new dialog, select all of the raster files (Shift-Click to multi select). 

 
8. Near the bottom of the Image Analysis window locate the section called “Processing”. 

a. Find the dropdown (probably below a color gradient) that contains items called “Blend”, “Last”, “First”, “Min”, 

“Max”, and “Mean” 

b. Select “Mean” from this list. 

c. Click the button beside the dropdown that looks like two grids and a plus sign. 
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9. A new image layer should now have appeared. Remove all of the original image layers by right-clicking and selecting 

‘Remove’ from the Image Analysis window. The map should now have a single layer in it that is a combination of all of 

the other images. 

10. Right-click on the item called “Layers” at the top of the Table of Contents (resembling a stack of yellow papers). 

a) Select “Properties…” 

b) Select the tab labeled “Coordinate System” 

c) Enter ‘102100’ into the “Type here to search” text box (similar to the previous step) 

d) Select the item labeled “WGS 1984 Web Mercator (auxiliary sphere)” and press OK. 

e) If a warning dialog appears regarding coordinate system differences, select “es”.  

11. Above the table of contents, click the “globe” shaped button to change the map so that all of the imagery is visible. 

Failing to complete this step will result in missing pieces of map data. 

12. Navigate to “File>Share As” and select “Tile Package” from the top menu of ArcMap 

 
a) In the ‘Tile Package’ tab, choose “Save Package to File”. 

b) Click the folder icon and navigate to your map directory. 

c) Name the file an appropriate name for your map pack. 

d) In the ‘Tile Format’ tab, choose “MIXED” for ‘Tile Format’  

e) Move the slider under “Levels of Detail” to a value of no less than ‘16 of 20’ but no higher than ’19 of 20’.  
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Note: the more levels of detail, the larger the file size of the map package. Generally 17 or 18 are sufficient unless 

you have exceptionally high-resolution imagery 

f) In the ‘Item Description’ tab, fill out the ‘Summary’ and ‘Tags’ textboxes. These are required by ArcGIS but will not 

be used by ICOMC2. Simply entering the name of the map pack here is fine. 

g) Click the “Analyze” (green checkbox) button at the top of the “Tile Package” window.  

h) A dialog will appear at the bottom of ICOMC2 that may have various low to medium severity warnings regarding

layer drawing and projections. These are OK and can be ignored. If there are other  high severity errors, revisit 

previous steps or address the error specifically. 

 
i) Press the “Share” button in the “Tile Package” window to begin execution. This operation may take a very long 

time depending on the amount of data and tile levels.  ou can view the progress in the “Packaging” Dialog. Do not 

attempt to use ArcMap during this process. If possible, simply leave the computer alone until it finishes. If an error 

occurs during packaging, it will have to be re-“Shared”. 

Note: If prompted to save the map document after clicking “Share”, choose “es” 

 
13.  Once packaging has completed, a dialog will appear with the location of the package. ArcMap may now be closed. 

14. The map pack may now be shared and used via the map directory. To install the map pack, navigate to the map 

directory in INEXA Control / ICOMC2’s Map Manager and select the TPK file. 
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Appendix B: Simulated Route Creation 

Introduction 
This appendix section will guide you through creating a simulated route for INEXA Control 2.1 & ICOMC2 2.1. This tutorial utilizes the 

Google Earth Pro mapping software to generate .KML files (routes).  The tutorial is for demonstration purposes only and Insitu does 

not support or is affiliated with this software.   

Minimum Prerequisites 
 Google Earth Pro software must be installed.  https://www.google.com/earth/explore/products/desktop.html 

Creating a Simulated Route 
To create a .KML file using Google Earth Pro, complete the following steps: 

1. Launch Google Earth Pro and uncheck Points of Interest and Other Features in the Layers menu. 
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2. Focus the map on the location where you would like to create a new route and select the Add Path option from the Google 

Earth application menu. 

3. Give the path a Name in the Google Earth – New Path configuration dialog box. 

4. Resize and move the New Path configuration dialog box to the side so it does not conflict with the path creation activity. 

Note: If you close the New Path configuration dialog box, you will exit the path generation process. 

5. Position the cursor over the map location where you would like to begin creating a path (route) and click the mouse. Reposition

the mouse to the next point on the map for the path and mouse-click.  Continue this process until the entire path is correctly 

laid out. 

Note: In the upper right hand corner of the Google Earth map are navigation tools that allow you to reposition the map, zoom-

in, zoom-out, or adjust the north-up reference point of the map.  These tools allow you reposition and focus the map without 

exiting the path/route creation process. 

Note: 

 Continuous Loop Routes – If you want to create a route where simulated vehicles travel in a continuous loop, position the 

final path waypoint over the top of the first path waypoint and mouse click. 

 Point-to-Point Routes – If you want to create a route where simulated vehicles travel the course of the route, disappear at 

the end of the route, and re-spawn at the beginning of the route, leave the route open (do not make the first and last path 

waypoints the same point). 

6. Select OK to save the newly created path. 

 

 



© 2017 Insitu Inc., All Rights Reserved Page 138 Insitu Proprietary 
 

7. Right-click on the newly created route in the My Places map menu and select the Save Place A… option. 

 

8. In the Save file… dialog, select the Save as type: drop-down menu and change the file type to Kml (*.kml). 

9. Select the Save button. 

Note: Take note of the directory where the .kml file will be saved before clicking the Save button. 

 


